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Chapter 1  

Introducing QuickBooks 

Topics 

In this chapter, you will learn about the following topics:  

• The QuickBooks Product Line (page 1) 

• Accounting 101 (page 2) 

• QuickBooks Files (page 5) 

• Opening Portable Company Files (page 9) 

• Restoring Backup Files (page 13) 

• QuickBooks User Interface Features (page 17) 

• Entering Transactions in QuickBooks (page 21) 

• QuickBooks Help (page 26) 

QuickBooks is one of the most powerful tools you will use in managing your business. QuickBooks isn’t 

just a robust bookkeeping program, QuickBooks is a management tool. When set up and used properly, 

QuickBooks allows you to track and manage income, expenses, bank accounts, receivables, inventory, 

job costs, fixed assets, payables, loans, payroll, billable time, and equity in your company. It also 

provides you with detailed reports that are essential to making good business decisions.  

QuickBooks helps small business owners run their businesses efficiently without worrying about the 

debits and credits of accounting entries. However, to use QuickBooks effectively, you still need to 

understand how QuickBooks is structured, how its files work, how to navigate in the system to do tasks, 

and how to retrieve information about your business. In this chapter you’ll learn some of the basics of 

the QuickBooks program and then you will explore the world of accounting.  

The QuickBooks Product Line 

The QuickBooks family of products is designed to be easy to use, while providing a comprehensive set of 

accounting tools including: general ledger, inventory, accounts receivable, accounts payable, sales tax, 

and financial reporting. In addition, a variety of optional, fee-based payroll services, merchant account 

services, and other add-on products integrate with the QuickBooks software.  

QuickBooks Desktop vs. QuickBooks Online 

Intuit offers two distinctly different ways to use QuickBooks. One version is installed on your local 

computer and is referred to as QuickBooks Desktop. The other is a cloud-based application that isn’t 

installed on your individual computer but is available online through a web browser or app on a 

smartphone or tablet. This version is called QuickBooks Online. The online edition has different, yet 

similar, features to QuickBooks Desktop. This textbook covers QuickBooks Desktop.  

QuickBooks Editions 

The QuickBooks Desktop product line includes several separate product editions: QuickBooks Pro, 

QuickBooks Premier, QuickBooks Accountant and QuickBooks Enterprise. The Premier and Enterprise 

editions are further broken down into six industry-specific editions for General Business, General 
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Contractor, Manufacturing & Wholesale, Nonprofit, Professional Services, and Retail. All editions of 

QuickBooks support multiple users, however, each user must have the same version of QuickBooks to 

access the file. 

This book covers the features and usage of QuickBooks Pro, Premier (non-industry specific), and 

Accountant, since most small businesses will use one of these editions. Also, once you learn how to use 

one of these editions, you’ll be prepared to use any of the other editions. For a comparison of all editions 

and options, see www.quickbooks.com. 

QuickBooks Releases 

Occasionally, errors are found in the QuickBooks software after the product is released for sale. As 

errors are discovered, Intuit fixes the problem and provides program “patches” via the Internet. Each 

patch increases the Release Level of the QuickBooks application. To see what release level of the 

software you have, press Ctrl+1 (or F2) while QuickBooks is running. At the top of the window, you will 

see the QuickBooks product information including the release level. 

  
Figure 1-1 Product information window showing version and release 

This book is based on QuickBooks Accountant 2018 release R4P. If you have a different release, you 

may see some slight differences compared to the screens in this book, but most likely you won’t see any 

differences. 

To patch your software with the latest maintenance release, download this release by selecting the Help 

menu and then selecting Update QuickBooks. Follow the instructions on these screens to download and 

install maintenance releases in QuickBooks via the Internet.  

Accounting 101 

Having a basic background in the accounting process will help you learn QuickBooks and run your 

business. In this section, we look at some basic accounting concepts and how they relate to QuickBooks.  

Accounting’s Focus 

Accounting’s primary concern is the accurate recording and categorizing of transactions so that you can 

produce reports that accurately portray the financial health of your organization. Put another way, 

accounting’s focus is on whether your organization is succeeding and how well it is succeeding.  

The purpose of accounting is to serve management, investors, creditors, and government agencies. 

Accounting reports allow any of these groups to assess the financial position of the organization relative 

to its debts (liabilities), its capabilities to satisfy those debts and continue operations (assets), and the 

difference between them (net worth or equity).  

The fundamental equation (called the Accounting Equation) that governs all accounting is: 

Assets = Liabilities + Equity, or Equity = Assets - Liabilities. 

Accounts, Accounts, Everywhere Accounts 

Many factors go into making an organization work. Money and value are attached to everything that is 

associated with operating a company — cash, equipment, rent, utilities, wages, raw materials, 

merchandise, and so on. For an organization to understand its financial position, business transactions 

need to be recorded, summarized, balanced, and presented in reports according to the rules of 

accounting. 
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Business transactions (e.g., sales, purchases, operating expense payments) are recorded in several 

types of ledgers, called accounts. The summary of all transactions in all ledgers for a company is called 

the General Ledger. A listing of every account in the General Ledger is called the Chart of Accounts.  

Each account summarizes transactions that increase or decrease the equity in your organization. The 

figure below shows a general picture of the effect your accounts have on the equity of your organization. 

Some accounts (those on the left) increase equity when they are increased, while others (those on the 

right) decrease equity when they are increased. 

 
So, let’s return to the Accounting Equation. To understand the accounting equation, consider the 

following statement. Everything a company owns was purchased by funds from creditors or by the 

owner’s stake in the company. 

Account Types and Financial Reports 

Each account in the general ledger has a type, which describes what kind of business transaction is 

stored in that account. There are primarily five types of accounts: asset, liability, equity, income, and 

expense. Assets, liabilities, and equity accounts are associated with the Balance Sheet report which is 

used to analyze the net worth of a business. The income and expense accounts are associated with the 

Profit and Loss report (also called Income Statement) which is used to analyze the operating profit or 

loss for a business over a specific time range (month, quarter, year, etc.). 

The Balance Sheet report preserves the fundamental accounting equation - Total assets always equal 

the total liabilities plus equity, between the accounts. This means that the total of the assets (which 

represent what the company “owns”) is always equal to the sum of the liabilities (representing what the 

company owes) plus the equity (representing the owner’s interest in the company). Although income and 

expense accounts are not directly shown in the accounting equation, they do affect this equation via the 

equity account as shown below. 

The income and expenses are tracked throughout the year, as business transactions occur, and are 

totaled at the end of the year to calculate Net Income (or Loss). Net income (total revenues minus total 

expenses) increases the owner’s equity in the business, and net loss (when expenses exceed revenues) 

decreases the owner’s equity in the business. Thus, the Income and Expense accounts indirectly affect 

the Equity component of the Accounting Equation of Assets = Liabilities + Equity, where Equity increases 

or decreases each year depending on whether the year’s income exceeds expenses or not.  

At the end of the year, the balance of each income and expense account is reset to zero so these 

accounts can track the next year’s transactions.  

Double-Entry Accounting 

Double-entry accounting is the technique that makes the Accounting Equation work. It divides each 

account into two sides. One side is a record of transactions that increase the account and the other side 

is a record of all transactions that decrease the account. One side (the left side) is for debits, and the 

other (the right side) is for credits. Depending on the type of account, a debit might increase the account 

or decrease it. The same is true of credits. Therefore, debits are not always bad and credits are not 

always good. They are just part of the system of accounting. However, the rule of double-entry 
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accounting is that total debits must always equal total credits. Every transaction creates a debit in one 

or more accounts and a credit in one or more accounts. If the debits and credits for any transaction are 

not equal, the transaction has an error or is incomplete.  

Accounting Behind the Scenes 

Recording and categorizing all of your business transactions into the proper accounts, summarizing and 

adjusting them, and then preparing financial statements can be an enormous, labor-intensive task 

without the help of a computer and software. This is where QuickBooks comes in. QuickBooks focuses 

on ease of use and hiding accounting details. To make all this possible, QuickBooks uses components 

like accounts, items, forms, registers, and lists, which are discussed later in the chapter. Familiar-looking 

forms such as invoices, checks, and bills are used for data entry. As you enter data in forms, QuickBooks 

handles the accounting entries for you. Thus, business owners can use QuickBooks to efficiently run a 

business without getting bogged down with the debits and credits of accounting entries.  

QuickBooks also handles double-entry for you. Every transaction you enter in the program automatically 

becomes a debit to one or more accounts and a credit to one or more other accounts, and QuickBooks 

won’t let you record the transaction until the total of the debits equals the total of the credits. This 

means you can create reports that show the transactions in the full double-entry accounting format 

whenever you need them, allowing you to focus on the business transaction rather than the debits and 

credits in the General Ledger. 

Cash or accrual method, as discussed in the next section, is handled in QuickBooks as a simple 

reporting option. You can create reports for either cash or accrual basis regardless of the method you 

use for taxes.  

As the book introduces new transaction types (e.g., Invoices, Bills, or Checks), the text will include a 

section called “The accounting behind the scenes.” For example, when you first learn about invoices you 

will see the following message: 

The accounting behind the scenes:  

When you create an Invoice, QuickBooks increases (with a debit) Accounts Receivable 

and increases (with a credit) the appropriate income account. If applicable, Invoices and 

Sales Receipts also increase (with a credit) the sales tax liability account. 

Letting QuickBooks handle the accounting behind the scenes means you can focus on your organization 

and identify the important factors that will help you succeed. Once you identify these factors, you can 

use QuickBooks to monitor them and provide information that will guide you in managing your 

operations. 

Accounting for the Future: Cash or Accrual? 

Another critical aspect of accounting is managing for the future. Many times, your organization will have 

assets and liabilities that represent money owed to the company, or owed to others by the company, but 

are not yet due. For example, you may have sold something to a customer and sent an invoice, but the 

payment has not been received. In this case, you have an outstanding receivable. Similarly, you may 

have a bill for insurance that is not yet due. In this case, you have an outstanding payable. 

An accounting system that uses the accrual basis method of accounting tracks these receivables and 

payables and uses them to evaluate a company’s financial position. The accrual basis method specifies 

that revenues and expenses are recognized in the period in which the transactions occur, rather than in 

the period in which cash changes hands. This helps you more accurately understand the true profitability 

of the business in each period. Assets, liabilities, income, and expenses are entered when you know 

about them, and they are used to identify what you need on hand to meet both current, and known, 

future obligations.  
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In the cash basis method, revenues and expenses are not recognized until cash changes hands. So, 

revenue is recognized when the customer pays, and an expense is recognized when you pay the bill for 

the expense. In most cash basis systems, you must use an outside system to track open invoices and 

unpaid bills, which means you cannot view both cash and accrual reports without going to several places 

to find information. However, in QuickBooks, you can record transactions such as invoices and bills to 

facilitate accrual basis reporting, and you can create cash basis reports that remove the receivables and 

payables with the same system. 

Although certain types of organizations can use the cash basis method of accounting (many are not 

allowed to do so under IRS regulations), the accrual method provides the most accurate picture for 

managing your organization. You should check with your tax accountant to determine which accounting 

method — cash or accrual — is best for you. 

Academy Photography  

Throughout this book, you will see references to a fictitious company called Academy Photography. 

Academy Photography is a photography studio that also sells camera equipment. This company uses 

QuickBooks for its accounting and business management. Academy Photography may not be exactly like 

your business; however, the examples in this text that focus on Academy Photography are generic 

enough to guide you on your own use of QuickBooks.  

Academy Photography has two locations, one in San Jose and another in Walnut Creek. In order for 

management to separately track revenue and expenses for each store, Academy Photography uses 

Classes in QuickBooks. As you proceed through the book, you’ll see how each transaction (bill, check, 

invoice, etc.) is tagged with what Class it belongs to, so that later you can create reports like Profit & 

Loss by Class. Classes can be used to separately track departments, profit centers, store locations, or 

funds in any business. 

Academy Photography also needs to separately track revenue and expenses for each job it performs. 

When a customer orders a photo shoot, Academy Photography needs to track all of the revenue and 

expenses specifically related to that job so it can look back and see how profitable the job was. This 

concept is called job costing, and many different businesses need to track jobs in similar ways. 

As you think through the examples with Academy Photography, ask yourself what parallels you see to 

your own organization. Certainly, areas such as salaries, supplies, equipment, and others will be 

appropriate for your setup, but the names and specifics of the accounts, items, lists, and forms will 

probably be different. 

QuickBooks Files 

Before using QuickBooks, it is important for you to understand how QuickBooks files are structured and 

used. QuickBooks has three primary types of files described below. All file types can be opened using the 

Open or Restore Company option from the File menu. 

1. Working Data Files – These files are used to enter transactions and create reports. These can 

also be called the Company Files. (File Extension .QBW) 

2. Portable Company Files –These files are a compact version of the company data files and are 

used to transport the file between computers. These files should never be used to back up your 

QuickBooks data. These files must be “Restored” to a working data file to be used. (File 

Extension .QBM) 

3. Backup Files –These files are a compressed version of the company data files and are used as 

backup to safeguard the information. These files cannot be used directly within QuickBooks and 

must be “Restored” to working data file format. (File Extension .QBB) 

This means, if you name your company file ABC, QuickBooks will store the working data file as 

“ABC.QBW.” When you back up your company file using the QuickBooks Backup function, QuickBooks 

will store your backup file with the name “ABC.QBB.” If you create a portable data file using the 

QuickBooks Portable file creation function, the portable file “ABC.QBM” will be created.  
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In addition to the Backup and Restore process, which moves the complete QuickBooks file between 

computers, QuickBooks also has a feature called the Accountant’s Copy. This feature enables an 

accounting professional to review and make corrections to a special copy of the client’s company file 

while the client continues to work. Then the client can merge the accountant’s changes back into the 

original file. See the QuickBooks Help Index for information on this feature. 

Important:  

Each file type has a specific purpose and should be used accordingly. Working data files 

are used to enter data and run reports, backup files are used to safeguard the data, and 

portable files are compressed files used to transport data via the Internet where smaller 

files transfer faster. 

Creating a New File 

There are four ways to create a new QuickBooks file, Express Start, Detailed Start, Company Based on 

an Existing Company, and Conversion from Other Accounting Software. Although it is possible to create 

a QuickBooks file relatively quickly using Express Start, we recommend utilizing a 12-Step process for 

creating a file to properly set up accounts and account balances. We have placed the chapter that 

explains file setup later in the book so you will be able to utilize knowledge gained in earlier chapters. 

You can learn more about file setup in our File Setup chapter starting on page 437.  

Opening a QuickBooks Sample File 

For learning purposes, QuickBooks provides sample data files that allow you to explore the program. To 

open a sample data file, follow these steps: 

Step 1. Launch the QuickBooks program by double clicking the icon on your desktop or selecting 

it from the Windows Start menu.  

Step 2. When QuickBooks opens, you will either see the No Company Open window (Figure 1-2) 

or you will be prompted to enter the password for the last working data file used.  

 

No Company Open window is displayed if you are opening QuickBooks for the first time or 

if you closed the working data file before exiting in your last session. By default, the last 

working data file used will open, if you closed the QuickBooks program before closing the 

file.  

 
Figure 1-2 No Company Open window 
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Step 3. If you don’t see the No Company Open window (Figure 1-2), but instead see a prompt to 

enter a password to the last working data file used (Figure 1-3). Click Cancel.  

 
Figure 1-3 QuickBooks Desktop Login window 

Step 4. Click Open a Sample file button and select Sample product-based business from the list. 

The selected sample file will open with the QuickBooks Information screen (see Figure 

1-4).  

Step 5. Click OK to continue. 

  
Figure 1-4 Sample File Information Screen 

Step 6. The sample file you selected will open. If you see the Accountant Center or the External 

Accountant message, close the window by clicking the X in the top right corner. You can 

uncheck the box that says Show window when opening a company file and close the 

window of the Accountant Center, or check Don’t show this again in the External 

Accountant window. 

Opening Other QuickBooks Data Files  

If you want to open a QuickBooks company file, other than the sample data files, follow the steps below. 

We will not complete these steps now, but will use a restored portable file in the next section. 

DO NOT PERFORM THESE STEPS. THEY ARE FOR REFERENCE ONLY. 

1. Launch the QuickBooks program by double clicking the icon on your desktop or selecting it from 

the Windows Start menu. When QuickBooks opens, it launches the data file you previously had 

open when you last exited the program, unless you specifically closed the data file before exiting. 

2. To open a different file, select the File menu and then select Open or Restore Company (see 

Figure 1-5). 
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Figure 1-5 File menu 

3. In the Open or Restore Company window, select Open a company file and click Next. 

 
Figure 1-6 Open or Restore Company 

4. Set the Look in field to the folder on your hard disk where you store your QuickBooks file (see 

Figure 1-7). 

  
Figure 1-7 Selecting the folder where the QuickBooks files are stored 

5. Select the file from the list of QuickBooks files. Then click Open. 

Note: When you open a data file, depending on today’s date, you may see one or more 

“Alerts” for learning to process credit cards, pay taxes, or similar activities. Click Mark as 

Done when you see these alerts. 
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Your company file will open, and you’ll be ready to work with QuickBooks. 

Closing QuickBooks Files 

Step 1. Close the company data file by selecting Close Company from the File menu (see Figure 

1-8). If you skip this step, this data file will open automatically the next time you start the 

QuickBooks program. 

 
Figure 1-8 Close Company File option 

Opening Multiple Files 

It is possible to open two company files at the same time if you are using QuickBooks Accountant or 

Enterprise, however, the activities that can be performed in the second file are very limited. We 

recommend that you use one file at a time by closing a file before opening or restoring a different file.  

Closing the QuickBooks Program 

Just as with any other Windows program, you can close the QuickBooks program by clicking the close 

button, which looks like an X, at the upper right hand corner of the QuickBooks window, or by selecting 

Exit from the File menu. The Exiting QuickBooks window will appear to confirm that you want to exit the 

QuickBooks program, as opposed to closing a window in QuickBooks. You can disable this message by 

checking the box next to Do not display this message in the future (see Figure 1-9). 

  
Figure 1-9 Exiting QuickBooks window 

Opening Portable Company Files 

Portable Company Files are compact company data files that can be easily transported. The exercise 

files that accompany this book are Portable Company Files. You will need to open these exercise files at 

the start of each chapter and each problem. 

Note: 

When you move a data file from one computer (computer A) to another (computer B), any 

data you enter on computer B will cause the file on the computer A to become “obsolete.” 

Take care to make sure you are always working in the true, active data file.  
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To open portable files follow the steps below.  

Step 1. Select the Open or Restore Company option from the File menu  

Step 2. QuickBooks displays the Open or Restore Company window (see Figure 1-10). Select 

Restore a portable file (.QBM) and click Next. 

 
Figure 1-10 Open or Restore Company window 

Step 3. QuickBooks displays the Open Portable Company File window (see Figure 1-11). Navigate 

to the location of your exercise files. You may need to ask your instructor if you do not 

know this location. Once you are viewing the contents of the correct folder, select Intro-

18.QBM and click Open. 

  
Figure 1-11 Open Portable Company File window 
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Step 4. Next you will need to tell QuickBooks where to save the working file that will be created 

from the portable file (see Figure 1-12). Click Next in the Open or Restore Company 

window to continue. 

  
Figure 1-12 Open or Restore Company Location 

Step 5. The Save Company File as window displays (see Figure 1-13). Ask your instructor or 

choose a location to save the file. When you have navigated to the appropriate folder, 

click Save. 

  
Figure 1-13 Save Company File as window 

Step 6. The QuickBooks Desktop Login window opens (see Figure 1-3). The password to this and 

every exercise file in this book is Sleeter18. The password is case sensitive so make sure 

you capitalize the first letter S in Sleeter18. Enter Sleeter18 in the Password field and 

click OK.  
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Note:  

Every QuickBooks file that uses the QuickBooks 2018 edition is required to have a 

complex password. The complex password is required to be 7 characters long and 

contain at least one uppercase letter and at least one numerical digit. Although we use 

the same password for all the exercise files in this textbook, we recommend that you use 

a different password for your own or your employer’s QuickBooks file. For more on file 

passwords see page 474.  

Step 7. If asked to update your company file, click Yes. 

Step 8. If you see the QuickBooks Desktop Information window saying that the Portable company 

file has been successfully opened, click OK to continue.  

Step 9. Once the Intro-18.QBW company file finishes opening, you will see the Home page. 

Creating Portable Company Files 

Although we will not create one now, you can also create a Portable file using the following steps. 

DO NOT PERFORM THESE STEPS. THEY ARE FOR REFERENCE ONLY. 

1. Select the Create Copy option from the File menu (see Figure 1-14). 

 
Figure 1-14 Create Copy  

2. The Save Copy or Backup window displays. Select the Portable company file option and click Next.  

 
Figure 1-15 Save Copy or Backup window 
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3. The Save Portable Company File window appears. The default file name in the File name field is 

the same as the working file name with “(Portable)” added to the end. Navigate to the student file 

location and click Save. 

4. The message shown in Figure 1-16 will appear before the portable file is created. Click OK to 

continue. 

  
Figure 1-16 Message for creating portable company file 

5. QuickBooks displays the QuickBooks Desktop Information dialog box (see Figure 1-17). Click OK 

to return to the working data file.  

  
Figure 1-17 Message that the Portable File has been successfully created 

Restoring Backup Files 

When working with important financial information, creating backup files is a crucial safeguard against 

data loss. Every business should conduct regular backups of company information. QuickBooks has 

useful tools to automate this process. 

In the event of an emergency, you may need to restore lost or damaged data. For example, if your 

computer’s hard drive fails, you can restore your backup onto another computer and continue to work. 

Note: 

Portable files should never be used as a substitute for backup files. Backup files are 

larger than portable files and hold more information about the company.  

Backing up Your Data File 

Backing up your data is one of the most important safeguards you have to ensure the safety of your 

data.  

DO NOT PERFORM THESE STEPS. THEY ARE FOR REFERENCE ONLY. 

1. To back up your company file, select Create Copy from the File menu.  

2. Choose Backup copy from the Save Copy or Backup window (see Figure 1-18). Click Next.  
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3. You are given the option to save the backup to a local area, such as a removable hard disk, or an 

online backup using a fee-based service available from Intuit. Online backup is a good option for 

many companies.  

 

Choose Local backup and click Next. 

 
Figure 1-18 Save Copy or Backup window 

4. The Backup Options window is displayed (see Figure 1-19). Under the Local backup only section, 

click the Browse button.  

 
Figure 1-19 Backup Options window 

5. Select the folder where you want to store your backup file (see Figure 1-20). You should store the 

backup files in a safe location, preferably on a different drive than your working data file. That 

way, if the drive with the working file is damaged, the backup will still be available.  
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Figure 1-20 Backup options Browse for Folder window 

6. When finished, click OK. 

7. The Save Copy or Backup window is displayed (see Figure 1-21). You can save a backup now, 

schedule future backups, or both. Select Only schedule future backups and click Next. 

 
Figure 1-21 Save Copy or Backup window 

8. In the Save Copy or Backup window, select New under the Back up on a schedule area. 
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Figure 1-22 Save Copy or Backup window 

9. The Schedule Backup window appears (see Figure 1-23). Enter a descriptive name for the backup, 

the location of the folder to contain the backups, and the time when the backup file will be 

created.  

 
Figure 1-23 Schedule Backup window 

10. When finished, click OK to close the Schedule Backup window.  

11. The Store Windows Password window opens. Enter your Windows username and password and 

click OK. 

12. Click Finish to close the Schedule Backup window. 

13. If necessary, click OK to close the QuickBooks: Backups have been scheduled as specified. 

Window.  

14. If necessary, click No, Thanks for the offer to try Online Backup. 
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Restoring a Backup File 

To restore a QuickBooks backup file, follow these steps. 

DO NOT PERFORM THESE STEPS. THEY ARE FOR REFERENCE ONLY. 

1. Select the File menu and then select Open or Restore Company. 

2. Choose Restore a backup copy from the Open or Restore Company window and click Next. 

3. In the Open or Restore Company window you can specify whether the file is stored locally or 

through Intuit’s fee-based Online Backup service. Choose Local backup and click Next. 

4. The Open Backup Copy window allows you to specify where the backup file is located. Navigate to 

the folder that contains the file, select it and click Open.  

5. The Open or Restore Company window displays. Click Next.  

6. The Save Company File as window allows you to specify where to restore the working files. 

Navigate to the appropriate folder and click Save. QuickBooks will then restore your backup file in 

the folder you specified. You may be prompted to enter a password. When QuickBooks restores 

the file, it creates a .QBW file. 

7. After completion, a window displays that the new file has been successfully restored (see Figure 

1-24). 

 
Figure 1-24 After restoring backup file 

Note: When you restore a data file, depending on today’s date, you may see one or more 

“Alerts” for learning to process credit cards, pay taxes, or similar activities. Click Mark as 

Done when you see these alerts. 

QuickBooks User Interface Features 

QuickBooks provides a number of shortcuts and aids that assist the user in entering information and 

transactions. You should become familiar with these features so you can get to a task quickly. There are 

various methods of accessing the data entry windows: the Home page, Snapshots, Menus, QuickBooks 

Centers, Icon Bar, and Shortcut Keys. 

Home Page 

As soon as you open a company file, QuickBooks displays the Home page (Figure 1-25). The Home page 

is broken into five sections – each dealing with a separate functional area of a business. These areas 

are: Vendors, Customers, Employees, Company, and Banking. Each area has icons to facilitate easy 

access to QuickBooks tasks. The Home page also displays a flow diagram showing the interdependency 

between tasks.  
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Figure 1-25 QuickBooks Accountant 2018 Home page 

To start a task, just click on its related icon on the Home page. If you close the Home page, it can be 

opened by clicking on the Home icon on the Icon bar, or by selecting Home Page from the Company 

menu.  

Centers 

QuickBooks Centers are organized to give pertinent information in one place. There are several Centers 

for specific relationships and tasks.  

Customer, Vendor, and Employee Centers are very important since they provide the only way to access a 

list of all your customers, vendors, and employees. These three lists are referred to as the Center-based 

Lists. These Centers summarize general information and transactions in the same area. For example, 

the Customer Center shows the customer balance, their general information, and all transactions for 

each customer (see Figure 1-26).  

 
Figure 1-26 Customer Center 
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Other Centers include the App Center, Bank Feeds Center, Report Center, and Doc Center. These 

Centers will be addressed later in this book. Centers can be opened from the Menus, Home Page and 

Iconbar.  

Snapshots 

The Snapshots is a single screen summary of different aspects of a company. Charts such as Income 

and Expense Trends, Previous Year Income Comparison, and Expense Breakdown are displayed along 

with important lists such as Account Balances and Customers Who Owe Money. The Snapshots can be 

easily customized to show the information that is of most interest to you and your company. 

 
Figure 1-27 Snapshots - your screen may vary 

Income Tracker 

 
Figure 1-28 Income Tracker – your screen may vary 

The Income Tracker provides a fast way to see the status of your unbilled and unpaid transactions as 

well as features for billing and collections.  
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Icon Bar 

 
Figure 1-29 Icon Bar 

The QuickBooks Icon Bar allows you to select activities and available services by clicking icons on the 

bar (see Figure 1-29). For example, you can open the Home page by clicking Home on the Icon Bar.  

Calendar 

You can view transactions on a Calendar. The calendar displays transactions on the Entered date and 

the Due date.  

Note:  

The Entered date is not literally the date when the transaction is entered into 

QuickBooks. It is the transaction date that is input on the transaction form. If you create 

an invoice on January 5th, 2019 and enter the date 1/6/2019 in the date field, the 

invoice will show on January 6th, 2019 on the Calendar.  

 
Figure 1-30 QuickBooks Calendar- your screen may vary 
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Step 1. Click the Calendar icon on the Company section of the Home page.  

Step 2. The Calendar window opens (see Figure 1-30). When finished, close the Calendar 

window. 

Entering Transactions in QuickBooks 

Whenever you buy or sell products or services, pay a bill, make a deposit at the bank, or transfer money, 

you need to enter a transaction into QuickBooks. 

Forms 

In QuickBooks, transactions are created by filling out familiar-looking forms such as invoices, bills, and 

checks. When you finish filling out a form, QuickBooks automatically records the accounting entries 

behind the scenes. Most forms in QuickBooks have drop-down lists to allow you to pick from a list 

instead of spelling the name of a customer, vendor, item, or account.  

Step 1. Click the Enter Bills icon on the Home page Vendors section (see Figure 1-31). 

 
Figure 1-31 Enter Bills on the Home page 

Step 2. Click the Previous button in the upper left corner of the Enter Bills window until you see 

the previously entered bill in Figure 1-32.  

Step 3. Click the down arrow next to the vendor field to see the drop-down list for vendors. 

 
Figure 1-32 Bill form 
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Step 4. Click the calendar icon next to the date to see the calendar drop-down menu.  

Step 5. When finished exploring, click the Revert button which will return the transaction to the 

last saved state.  

Step 6. Close the Enter Bills window. 

By using forms to enter transactions, you provide QuickBooks with all of the details of each transaction. 

For example, by using the Enter Bills form in Figure 1-32, QuickBooks will track the vendor balance, the 

due date of the bill, the discount terms, and the debits and credits in the General Ledger. This is a good 

example of how QuickBooks handles the accounting behind the scenes, and also provides management 

information beyond just the accounting entries. 

Lists 

Lists are one of the most important building blocks of QuickBooks. Lists store information that is used 

again and again to fill out forms. For example, when you set up a customer, including their name, 

address and other details, QuickBooks can use the information to automatically fill out an invoice. 

Similarly, when an Item is set up, QuickBooks can automatically fill in the Item’s description, price, and 

associated account information. This helps speed up data entry and reduce errors.  

Note: 

There are two kinds of lists — menu-based and center-based. Menu-based lists are 

accessible through the Lists menu and include the Item list and Terms list. Center-based 

lists include the Customer Center and Vendor Center, discussed on page 18. 

Lists can be viewed by selecting an icon from the Home page (for example, the Items & Services button), 

choosing a menu option from the Lists menu, or viewing a list through one of the various QuickBooks 

Centers. 

Accounts 

QuickBooks provides the means to efficiently track all of your business transactions by categorizing 

them into accounts. The Chart of Accounts is the list of these accounts.  

Step 1. To display the Chart of Accounts, click the Chart of Accounts icon on the Home page. 

Alternatively, you could select Chart of Accounts from the List menu, or press Ctrl+A.  

Step 2. Scroll through the list. Leave the Chart of Accounts open for the next exercise. 

By default, the Chart of Accounts is sorted by account number within each account type (see Figure 

1-33). The Name column shows the account names that you assign; the Type column shows their 

account type; the Balance Total column shows the balance for asset, liability, and equity accounts 

(except Retained Earnings), and the Attach column shows if there are attached documents.  
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Figure 1-33 Chart of Accounts List 

Note: 

New with QuickBooks 2018, you can now search for accounts in the Chart of Accounts.  

Registers 

Each asset, liability, and equity account (except Retained Earnings) has a register (see page 2 for more 

information on these account types). Registers allow you to view and edit transactions in a single 

window. Income and expense accounts do not have registers; rather, their transactions must be viewed 

in a report.  

Step 1. To open the Checking account register, double click on 10100 Checking in the Chart of 

Accounts list.  

Step 2. The Checking register opens (see Figure 1-34). Scroll through the register.  
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Figure 1-34 Checking account register 

Step 3. Close the Checking account register by clicking the close button in the upper right corner.  

Step 4. Double click the 40000 Services account. You may need to scroll down. This is an Income 

account.  

Step 5. Instead of opening a register, QuickBooks opens a report (see Figure 1-35). 

Step 6. If necessary, change the Dates field to All.  

Step 7. Close the report. 

 
Figure 1-35 Services Account QuickReport – your screen may vary  

Step 8. Close the Chart of Accounts.  

Items 

Items are used to track products and services. Since every business has its own unique set of products 

and services, QuickBooks can be customized by creating Items for each service or product your 

company buys or sells. For more detail on Items and the different Item Types, see page 253. 
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When you define Items, you associate Item names with Accounts in the Chart of Accounts. This 

association between Item names and Accounts is the “magic” that allows QuickBooks to automatically 

create the accounting entries behind each transaction.  

For example, Figure 1-37 displays the Item list. The Item, Camera SR32, is associated, or linked, to the 

Sales account in the Chart of Accounts. Every time the Camera SR32 Item is entered on an invoice, the 

dollar amount actually affects the Sales account in the Chart of Accounts.  

Items are necessary because to use a sales form in QuickBooks (e.g., invoices and sales receipts), you 

must use Items. On an invoice, for example, every line item will have a QuickBooks Item which may 

represent products, services, discounts, or sales tax.  

Step 1. To see what Items are available in the file, click the Items & Services icon on the Home 

page in the Company section (see Figure 1-36). Alternatively, you could select Item List 

from the Lists menu.  

 
Figure 1-36 Items & Services button on Home page 

Step 2. Figure 1-37 shows the Item list. Double click the Camera SR32 item. 

 
Figure 1-37 Item List 

Step 3. If the New Feature window opens, click OK.  

Step 4. The Edit Item window opens (see Figure 1-38). Notice this item is linked to the Sales 

account. Every time this item is entered on an invoice, it changes the Sales account.  

Step 5. Close the Edit Item and Item List windows.  
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Figure 1-38 Camera SR32 Edit Item window – your screen may vary 

QuickBooks Help 

Support Resources 

QuickBooks provides a variety of support resources that assist in using the program. Some of these 

resources are on the Internet and others are stored in help files locally along with the QuickBooks 

software on your computer. To access the support resources, select the Help menu and then select 

QuickBooks Desktop Help. QuickBooks will display answers to problems you might be having based on 

your recent activity. You can also enter a question and QuickBooks will search its Help Content and the 

Online Community for related answers.  

Certified QuickBooks ProAdvisors 

Certified QuickBooks ProAdvisors are independent consultants, accountants, bookkeepers, and 

educators who are proficient in QuickBooks and who can offer guidance to small businesses in various 

areas of business accounting. To find a Certified ProAdvisor, select Find a Local QuickBooks Desktop 

Expert from the Help menu. 
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Review Questions 

Comprehension Questions 

1. Explain the difference between a QuickBooks working data file, a QuickBooks backup file and a 

QuickBooks portable file. How can you differentiate between the three types of files on your 

hard disk? 

2. What is the main reason for creating portable files? 

3. Explain the importance of the QuickBooks Home page. 

4. Explain why it is important to enter transactions in QuickBooks using Forms rather than 

accounting entries. 

5. Describe the primary purpose of accounting in business. 

Multiple Choice 

Select the best answer(s) for each of the following: 

1. The fundamental accounting equation that governs all accounting is: 

a) Net income = Revenue - expenses. 

b) Assets + Liabilities = Equity. 

c) Assets = Liabilities + Equity. 

d) Assets = Liabilities - Equity. 

2. Which of the following statements is true? 

a) Debits are bad because they reduce income. 

b) Equity is increased by a net loss. 

c) Debits - credits = 0. 

d) Assets are increased with a credit entry. 

3. Under accrual accounting: 

a) A sale is not recorded until the customer pays the bill. 

b) Income and expenses are recognized when transactions occur. 

c) An expense is not recorded until you write the check. 

d) You must maintain two separate accounting systems. 

4. QuickBooks is: 

a) A job costing system. 

b) A payroll system. 

c) A double-entry accounting system. 

d) All of the above. 

5. Which is not a method of accessing the data entry screens? 

a) Menus 

b) Home page 

c) Icon bar 

d) Data entry button 
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Completion Statements 

1. As you enter data in familiar-looking ________, QuickBooks handles the __________ entries for 

you.  

2. You should ________ your data file regularly because it is one of the most important safeguards 

you can do to ensure the safety of your data. 

3. When you open your working data file, QuickBooks displays the _____ ______. This page is broken 

into five sections – each dealing with a separate functional area of a business.  

4. ____________ are used in QuickBooks Sales forms and represent what the company buys and 

sells. 

5. A list which shows all the accounts in your working data file is called the ______ ___ ______. 

Introduction Problem 1 

Restore the Intro-18Problem1.QBM file. The password to access this file is Sleeter18. 

1. Select Customers from the QuickBooks Icon Bar. This will display the Customer Center.  

a) What is the first customer listed on the left of the Customer Center?  

Note:  

The answer to this first question is AAA Services. If you don’t see AAA Services in the 

Customer Center, make sure to restore Intro-18Problem1.QBM as directed in the box 

above. This book uses specific files for each chapter and each problem. If you don’t 

restore the correct file, you will have trouble completing the exercises. 

b) In the Customers & Jobs Center, single click on Mason, Bob. What is Bob Mason’s 

balance?  

c) Click the Date drop down list above the transaction listing in the right-hand panel and 

scroll up to the top of the list to select All. How many transactions do you see and of what 

type? 

d) Close the Customer Center. 

2. From the Home Page, click the Enter Bills icon. The Enter Bills window opens.  

a) Click the previous button in the upper left corner. What is the name of the Vendor 

displayed on this Bill? 

b) What is the Bill Due date on this bill?  

3. From the Home page, click the Chart of Accounts icon to display the Chart of Accounts. 

a) What type of account is the Checking Account? 

b) How many total accounts are there of this same type? 

c) What is the Balance Total for the Money Market account? 

Introduction Problem 2 (Advanced) 

Restore the Intro-18Problem2.QBM file. The password to access this file is Sleeter18. 

1. Select Customers from the QuickBooks Icon Bar. This will display the Customer Center.  
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a) What is the first customer listed on the left of the Customer Center?  

Note:  

The answer to this first question is ABC International. If you don’t see ABC International in 

the Customer Center, make sure to restore Intro-18Problem2.QBM as directed in the box 

above. This book uses specific files for each chapter and each problem. If you don’t 

restore the correct file, you will have trouble completing the exercises. 

b) In the Customers & Jobs Center, single click on Cruz, Maria. What is Maria Cruz’s 

balance?  

c) Click the Date drop down list above the transaction listing in the right-hand panel and 

scroll up to the top of the list to select All. How many transactions do you see and of what 

type? 

d) Close the Customer Center. 

2. Select Vendors from the QuickBooks Icon Bar. This displays the Vendor Center.  

a) Double click Boswell Consulting . This opens the Edit Vendor window. What is the 

Address? Close the Edit Vendor window. 

b) Single click on Sinclair Insurance. What is the amount of Bill number 5055 to Sinclair 

Insurance? (You may need to set the Date to All as in Step 1.) 

c) Close the Vendor Center. 

3. From the Home page, click the Chart of Accounts icon to display the Chart of Accounts. 

a) What type of account is the Payroll Liabilities Account? 

b) How many accounts of type Fixed Asset are in the Chart of Accounts? 

c) How many accounts of type Other Current Asset are in the Chart of Accounts? 

4. While still in the Chart of Accounts, Double click the Checking account on the Chart of Accounts 

list. This will open the register for the Checking account. 

a) Who was the payee for the check on 2/10/2019? 

b) What was the amount of the check? 

c) Close the checking account register and Chart of Accounts list. 

5. Click the Create Invoices icon on the Home page, and then click on the Previous arrow (top left). 

a) What is the Invoice Number?  

b) Who is the Customer listed on this invoice? 

c) What is the first Item listed on this invoice?  

d) Close the invoice. 

6. Select the Chart of Accounts option from the Lists menu. Double click on the Checking account. 

a) Which vendor was paid by the last bill payment (BILLPMT) in the register? 

b) What is the Bill Payment Number?  

c) What is the amount of the last bill payment in the register? 

d) Close the Checking register and close the Chart of Accounts list. 

7. Click the Write Checks icon on the Home page and follow these steps:  
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a) Click on the Calendar icon immediately to the right of the Date field. Select tomorrow’s 

date in the Date field and press Tab.  

b) In the Pay to the Order of field, enter Ace Supply. Press Tab. 

c) Enter 80.00 in the Amount field and press Tab. 

d) Check the Print Later check box at the top of the window. 

e) What is the city displayed in the Address field on the check for Ace Supply? 

f) Click Clear and then close the check window.  

8. Select the Chart of Accounts option from the Lists menu and double click on Accounts Receivable. 

a) What is the ending balance in the account? 

b) Who was the customer on the last transaction in the register? 

c) Close the register and the Chart of Accounts. 

9. Click the Check Register icon on the Home page.  

a) Select 10100 – Checking from the Use Register dialog box.  

b) What is the ending balance in the checking register? 

c) Close the Checking Register. 

10. Close the working data file Intro-18Problem2.QBW. 

 


